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Special characters : If you need to put accents (tildes) like: ñ, á, é, í, ú, Ñ. You need to press SHIFT + ~ KEY until 

you find the correct accent. You will need to type the letter first then do the SHIFT + ~ KEY (The ~ is located next 

to #1 key on your keyboard).  

 

Extra spaces around punctuation are not allowed. For example:  Do not include spaces around a hyphen or other 

punctuation such as an apostrophe.  Any other characters like: periods, number signs, commas, etc., a warning box 

will appear.     

 

Suffix: Suffixes such as Jr I II III IV are allowed. Suffixes such as The I, The II, The III are not allowed. 

Professional titles such as MD, DMD, DNP, DO, RN, DDS, etc. should not be used in the suffix field.  Suffixes with 

periods, number signs, commas, etc. are also not allowed.  If the suffix is not in the dropdown type it in manually 

and the field will turn orange.  Example screenshot below. 

 
 

Field Help: In some of the fields containing the text cursor you can select F1 and you will see additional 

information about that field.  Screen shot below:   

. 

 

KEYBOARD SHORTCUTS 

  
The Tab key moves the user from field to field within the data entry form. Before the field is exited, it is edited for 

errors (unless the edits for the field are overridden or the field is queried). Fields are ordered left to right, top to 

bottom, in normal reading order.  When the Tab key is pressed in the last enterable field on a page, the notebook 

selects the next page and the text cursor is placed in the first enterable field on that next page. If a  page contains no 

enterable fields, it is skipped. 

 

Shift-Tab moves the user to the previously held field. It will not automatically switch  pages. 

 

Delete 

Put the cursor in the text field and hit the Delete key. 

 

F1 

Depressing F1 displays field help for the field your cursor is on. 

 

Ctrl- 0 (zero) 

The data entry form is built from labeled boxes which are referred to as paragraphs (in  Windows terminology, group 

boxes). Pressing Ctrl-0 will move the text cursor from the present field to the first enterable field in the next 

paragraph. 

 

 

Ctrl-R 
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This brings up a dialog box to ‘Reload the page’ with a warning indicating that the changes might not be saved. 

 

Ctrl-C 

This key copies the highlighted text to the clipboard. The field contents are not altered from the clipboard. 

 

Ctrl-V 

Pastes the contents of the Windows clipboard into the field containing the text cursor. The contents pasted by Ctrl-V 

replaces whatever may otherwise be in the field. 

 

Ctrl-X 

This shortcut cuts the present field and copies its contents to the Windows clipboard.  From the clipboard, it can be 

pasted into another data entry field, or into another Windows application which supports the clipboard. 

 

T (F and B) 

On many date fields the user can enter a “T”, for “today”, and the current system date will display. Additionally, the 

values “F”, for “forward” (the next following date), and “B”, for “back” (or, the immediately preceding date), are 

available. These values may be repeatedly entered to continue the process of either advancing or reversing the date 

one day at a time. 

 

Ctrl-S 

This saves the current Event. This is equivalent to the File / Save menu item. 

 

Left Mouse Click 

The left mouse button can be used to place the text cursor in a particular field by clicking  when the mouse cursor is 

over the desired field. The left mouse can also select notebook pages by clicking on the tab for the desired page. 

 

Right Mouse Click 

A menu of options for a field may be displayed by clicking the right mouse button when  the mouse cursor is 

positioned over the field.  This can be used to clear a field. 

 

Alt-F4 

This key combination displays a dialog box indicating Leave Site? With a message displaying ‘Changes you made 

may not be saved.’  If you click on the Leave button, Windows will close the web browser. 

 

Check Box Fields 

A left mouse click will toggle the checked state of a check box field. Pressing the space bar when the field is 

selected also toggles the state. 

  

Combo Box Fields 

Combo box fields associated with a dropdown list of values, are indicated by a small box with an inverted triangle to 

the right of the field. When a combo box is selected, several keys are operative. Up and Down arrows change the 

field contents to the next available value from the list.  Clicking on the inverted triangle with the left mouse button 

also toggles the drop-down list. Typing a partial character string when the field is selected will position the list to the 

first selection that begins with that string. For example, in a list  of US States, typing “A” positions to “Alabama” and 

“ALAS” positions to “Alaska”.  If user types “AL”, “Alabama” is displayed.  If you start typing and then you typed 

something in you didn’t want you can hit the Delete key to restore the dropdown list. 

 

NOTE:  If entry is not in dropdown list type it in manually and the field will turn orange.  Orange indicates that the 

field was manually entered.  If queried or overridden the field(s) turn aqua blue. 

 

‘U’ in date field – If you type in a U for unknown in the date field it will fill in all 9’s for the date.  

SUBSCRIPTION PAGE 
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The following link will take you to the Subscription page.  This page was established for Physicians, Funeral 

Directors, County Attorneys and County Coroners.  Select the link that best fits your job and interests.  You can also 

subscribe to the subscriptions page and each time it is updated with information you will be notified via an email 

alert. 

 

http://dhhs.ne.gov/Pages/Vital-Records-Partners.aspx 

Note:  Subscription Page is also located in the Help menu after login and it is also on the home page after login. 

 

DEFINITION OF TABS AND PARAGRAPHS IN ERS  

 

Tabs – Tabs are referred to the tabs at the top of the webpage where you enter the information on Decedent, Dec 

History, Disposition, Medical, Assigned, Demographics, Complete and Flags tabs. Screen shot below has a red 

rectangle around the tabs  with a label indicating tabs . 

 

NOTE:  The Medical and Flags Tab is for your information only. 

 

Paragraph – Refers to each section in a particular tab, for example ‘System’ and ‘Deceased’ are paragraphs in the 

Decedent Tab.  Screen shot below.  The word ‘Paragraph’ in italics with yellow labels is listed in each paragraph 

below.  In this document the paragraphs  are identified as black Italic font. 

 

 

NOTES UTILITY  
 

http://dhhs.ne.gov/Pages/Vital-Records-Partners.aspx
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The user can also add a note to the record or a particular field even after the user has finalized the record by  

selecting Actions and Show Notes.  

 

Click on Actions>Show Notes  

 

 
 

 

Notes window displays.  Click ‘New’ button to add a new note.    

 

 
 

Type in your note and click Save. 

 

 
You can also double click on the green Notes button in the upper right to access notes utility.  

 

 
 

You can see in the Notes grid that your Note was s uccessfully saved.   
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The user can also right click in a field to add a Notes.  Choose any field, right click and Select Notes .   

 
 

NOTE:  Once a note is added the ‘Notes Count’ highlighted in green at the top will display a count of the notes that 

were added.  You can look at notes by either clicking on the Actions>Notes or double clicking on the green 

highlighted box that says Notes count. 

 
The user can also add a note to the record or a particular field even after the user has finalized the reco rd by 

selecting Actions and Show Notes. However, it is preferred that the hospital comments section be primarily used for 

comments or notes (see Complete Tab). Only after the record has been finalized by the hospital (hospital 

complete=Y and saved) should the Notes feature be used.   

OVERRIDES AND QUERIES  
 

Depending upon the field and the given user’s security role, options of Override and Query may also be available. 

 

If fields are overridden please add a Note with an explanation as to why it was overridden.   

 

Note:  You should seldom use Query unless you are planning on finding out more information before completing 

the record.   
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Once you hit Override it turns the field aqua blue.  Example below is the Father’s last name does not agree with the 

decedent’s last name when male. 

 

 

HOW TO SEARCH WITHIN ERS 
 

Search Criteria 

 

On the Search Screen, first note that there are two tabs – the Search Criteria tab and the Search Results tab. 

 

The Search Criteria tab is where the criteria for the search are entered. The Search Results tab is where the 

results (record entries, if any) of that search is displayed. 

 

You can search by using the following special characters as well:  

 

 Search criteria  

%     Smi%  

_     Sm_th 

,A or ,D   Ascending or Descending 

NULL 
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<>NULL 

(X + Y)   Records with a value between (and including) X and Y 

IN(A+B+C)   Records with a value in that listed set 

>,>=,<>,<,<=  Other operators 

 

To search on Date fields you will need to include the slashes “/”, for example:  01/04/2019 

 

Fields included on the Search tab have been selected for their relevancy to the search for each Event. They typically 

include name fields, key date fields, facility fields and the like. Any one of these fields by itself is sufficient to 

institute the search. For example, a name field alone will yield search results. If, however, you wish to refine the 

search, additional search criteria can be entered in additional fields thereby narrowing the results set. 

 

Note, though, that while a greater number of fields used in the search will result in a more refined set of results, each 

of the criteria entered becomes part of the match process and this, in  turn, necessitates a greater accuracy in those 

criteria that are entered. Entering ‘Betty’ for a woman’s first name, for example, will cause the entire search to fail if 

the person’s name is  known to the system as ‘Elizabeth’. 

 

In addition to entering exact information for the search, other options are possible. 

 

%  - The percent sign allows the user to not enter some letters in the search field. For example, if the exact spelling 

of the decendent’s last name is not known, the user could enter the characters of the decedent’s last name that are 

known and use the %  to signify the remaining letters.  If, for example, “Smi% ” is used in the search field, it would 

find and display all records that started with “Smi”. Or, if the last part of the decedent’s name was known, the user 

could enter “% son” to locate all names that ended in “son”. 

 

_ (the underline character) – This character is used to denote that exactly 1 letter is unknown and can be anything. 

 

,A or ,D – When a “,A” is put in a search field, the resulting records will displayed in ascending order on that field. 

If a “,D” is put in a search field, the results will be in descending order on that field. This is used when a large result 

is expected. It can be used in combination with other search criteria. 

 

NULL – When this word is used in a search field, the records with an empty (or, null) value are displayed. For 

example, this might be used in the State File Number field to display those records that have not been numbered 

yet. 

 

<> NULL – This indicates a not null, or not empty, value – i.e., some sort of value is present.  

 

 (X+Y) – This is interpreted as “Search for records that have a value BETWEEN X and Y”.  This actually 

includes the values X and Y too. This can be used for any field including the state file number and the date fields 

that are true dates and not just s tring representations of the dates.  True dates are usually the dates that cannot have 

an unknown component. IN(A+B+C) – This search construction directs that at least one of the listed values be 

present - 

either A or B or C.   

 

Other operators – These include >,>=,<>,<,<=. For example the operator >= will find records with a value greater 

than or equal to the rest of the search field entered. To find a last name that  is greater than or equal to M, for 

example, the characters >= M would appear in the Last Name field. The <> operator means “not equal to”. 

 

From menu click on Search> Death.  The ‘Search (Death)’ screen displays: 
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WORK QUEUES 

 

On the home page the Work Queues are located in the upper right corner of the page.  Records rejected will be in the 

Funeral Director Rejects queue.  Funeral Director records still in progress will be in the Funeral Director in Progress  

queue.  The Number in the blue circle indicates how many records are in each queue. 
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ELECTRONIC REGISTRATION SYSTEM (ERS) INSTRUCTIONS 
 

Electronic Registration System (ERS) Log on Screen 

 

Enter: User Name, Password 

Click: Log In 

 

 
 

The following Information box may display with a message if there is a message to display:  The box will have 

messages like when the office is closed, system is down for maintenance, etc.  Click ‘X’ to close the message. 

 

 

 
 

The following page will display:  This page will display messages for all users in the ‘Attention All Users’ section 

and/or you may have messages under the header of ‘Messages’ for only certain roles. 
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NOTE:  In the Help menu you can also access the Handbook for Funeral Directors  as well as the Subscription page. 

User can hit F1 key which displays context-sensitive help for the field containing text.  You will need to hover over 

the label of the field. 

 

NOTE:  It is highly recommended to use Chrome or Safari when using this application.  Each field that is in 

focus will be highlighted yellow to indicate which field you are on.  If it is a checkbox field the label will be 

underlined. 

 

To enter a New Death record follow the instructions below: 

 

Click on File> New> Death to enter a new death certificate.  Or you can use the keys CTRL + D. 

 

 
 

Decedent Tab 

 
Begin entering the decedent’s information.  Various edits are in place in the system and will pop up if you enter 

anything incorrectly.   

 
NOTE:  You can do a Save Without Edits any time after entering the required fields which are noted by a red 

asterisk.  The following fields that are required are Decedent Last Name and Date of Death. 

 

If you get validation errors when doing a full save by doing a File >Save or green save button in the upper right 

corner it will not save the record.  At this point you will need to Save Without Edits to save the record or save any 

changes that have been made to the record. 
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System paragraph - overview 

 

This section is for Vital Records use. Your name (Created by) will be entered as you create the record.   

 

Paper/Electronic field will be defaulted to E. 

 

Record Status: Defaults to Normal 

 

Deceased paragraph  

 

Social Security Number - If unknown, please enter 999-99-9999. 

 

First Name – Enter First Name 

 

Middle Name – Enter middle name. 

 

Last Name – Enter the last name. 

 

Note:  In the Name fields of any paragraph the first letter of the first name, middle name and last name will 

automatically capitalize after tabbing off the field.   

 

You can also ‘Ignore the Casing’ rules by deleting the name in it and right click in the field and choose ‘Ignore 

Casing Rules’.  This allows you to capitalize whatever letters need to be capitalized, for example:  van Buren.   The 
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casing rules are automatically turned on for each field.  If you need another name field to be capitalized differently 

you will need to turn off casing rules for that field.   

 
 

NOTE:  If there is a special character in the middle of a name you will need to turn off Casing Rules. 

 

Suffix – Select from dropdown list 

 

Alias – Check box field.  The following rows will be enabled if this field is checked.  If this checkbox is not checked 

the fields will be disabled. You can add up to three alias names.  Please do not enter nicknames in these boxes. 

 

 
 

Sex – Select F = Female, M = Male, U = Unknown field. 

 

Date of death known?  Enter a Y or N.  If the date of death is not known, enter an N in this field.  This prompts the 

system to place the word “found” on the certificate in the date of death field on the decedent found field. 

 

Date of Death (String)  Enter in the Date of Death or you can use the calendar widget to choose the date. You 

cannot select a future date. 

 

 
 

Decedent found – This will autofill with Found if the Date of Death Known field is No. 

 

Country of Birth – Dropdown list, if not United States the State and City fields will not be entered. 

 

State of Birth – Select from the dropdown list. 

 

City of Birth – Select from the dropdown list.  If the city is not in the dropdown list type in the city name and tab.  

The field will turn orange. 

 
NOTE:  You can do this with any dropdown field where your information is not in the list. 

 

Date of Birth – Date of birth of decedent. 

 



 

15 
 

Age - This will calculate after entering Date of Birth.   

 

Age Unit – This will calculate after entering Date of Birth. 

NOTE:  If Date of Birth and Date of Death are the same you will need to enter the Age in the Age field and choose 

Age Unit from the dropdown.  

 

 
 

Age Days – Age Days is optional if Age Unit months is selected. 

 

 
 

Age Minutes – Age Minutes is optional if Age Unit Hours is selected.  

 

 
 

Social Security Number – Enter the social security number.  If the decedent does not have a social security number, 

enter 9’s.  Ex:  999-99-9999. 

 
Place of Death paragraph 

 

If the decedent died at home, the residence information will autofill from the information entered in the place of 

death.   

 

Once you have completed the last field on the screen, the system will automatically take you to the next screen for 

you to complete. 
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Type of Place of Death (select F1 for further instructions) – Select one of the following from the dropdown list:  

Assisted Living, Dead on Arrival, Decedent’s Home, Emergency Room/Outpatien t, Hospice Facility, Inpatient or 

Nursing Home/Long Term Care Facility.    

  

Facility Name – Select from the dropdown list.  The address, State, County, City and Zip Code will autofill.  When 

searching for a Facility Name you can search on the Facility or the City or both.  You can also search on partial 

facility name as well. Example below I typed in “CHI” and all facilities that have “chi” will display.  Screen shots 

below for examples. 

 

Partial Search on Facility Name: 

 
 

Search on City:  In this example ‘Lincoln’ is typed in Facility Name and everything associated with ‘Lincoln’ will 

display.   

 

 
 

Address Search:  In this example ‘22’ and everything associated with ‘22’ will display.  

 

 
 

Address – Address field will auto populate after selecting the Facility Name. 

 

Apt No – Apt number will auto populate after selecting the Facility Name. 

 

State – State will auto populate after selecting the Facility Name. 

 

County – County will auto populate after selecting the Facility Name. 

 

City – City will auto populate after selecting the Facility Name. 

 

Zip Code – Zip Code will auto populate after selecting the Facility Name.  
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NOTE:  If the decedent died at home and if the zipcode is not in list type it in and the field will turn orange.    

 

 
 

If the Place of Death is not in the list you can type it in manually and the field will turn orange.  The rest of the 

address information will need to be completed manually. 

 

 
 

If the Facility Name is not in the dropdown list type it in manually and the field will turn orange .  The rest of the 

address information will need to be completed manually.  Please contact Vital Records Help Desk so that they can 

verify and add to system.   

 

 
 
Residence paragraph 

 

If the decedent died at home, the residence information will autofill from the information entered in 

the place of death – you don’t have to type it.  You will need to complete the City Limits field. 

 

 

 
 

Street Address – enter street address 

 

Apt No – Enter apartment number 
 

In City Limits - Select Y or N 
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Country – Defaults to United States.  If not in the United States select Country from dropdown list. 

 

State – Select from dropdown list 

 

Zip, City, County – dropdown list.  You can put in partial zipcode and it will show city and county which user can 

choose the correct one.   

 

If you search by the zip code and put in a partial zip code it will bring back all the results that have those numbers in 

it.  For example if I type in ‘681’ you will see all zip codes starting with 681 and their associated city and county.  If 

you put in the County and/or City it will filter the zip code for that particular County and City.   See below:   

 

Searching on partial zipcode: 

 

 
 

Searching on county: 

 

 
 

Search on city: 
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If Zip Code not in list for Zip, City, County field select Other-Not in List from dropdown.  Then manually type in 

County, City and Zip Code and the Zip Code field will turn orange.  If the City is not in the dropdown then you can 

manually type it in the City field and the field will turn orange as well. 

 

 
Note:  Once you have completed the last field on the screen, the system will automatically take you to the next tab.  

 
County – dropdown list 

 

City – dropdown list 

 
Zip Code – Will autofill from the Zip, City, County field. 
 

Dec History Tab 

 

 

On the decedent history tab, enter the information as requested.  Please note the spouse’s last name is her maiden 

name as is the mother’s last name.  Spouse is require if they are married at time of death or optional if widowed. 

 
History paragraph 

 

Marital Status  – choose any of the following from the dropdown list:  Divorced, Married, Married but Separated, 

Never Married, Not Obtainable, Unknown or Widowed. 

 
If the informant is the spouse, you will enter her married name in the informant field. 

 
Spouse’s First Name – Enter first name 

Middle Name – Enter middle name 
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Last Name (Maiden) – Enter last name 

Suffix - select suffix from dropdown list 

Parents paragraph 

Father’s First Name – Enter first name 

Middle Name – Enter middle name 

Last Name – Last name is autofilled from the decedent paragraph if the decedent was male. 

  

  

Suffix – Select suffix from dropdown list 

Mother’s First Name – Enter first name 

Middle Name – Enter middle name 

Last Name – Enter last name 

Suffix – Select suffix from dropdown list 

U.S. Armed Forces Service paragraph 

US Armed Forces? Y/N – If yes the Begin and End Service dates are enabled. 

Begin Service – If part of date is unknown you can select F1 for field help for examples of how to enter the date. 

 

 

End Service – If date is unknown the same instructions apply as Begin Service date.  See screen shot above. 

Informant paragraph 

Note:  If decedent is married the spouse’s information will autofill.  If informant is not the spouse you will need to 

change the fields manually.  If the decedent is not married you will need to enter the fields manually.   
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First Name  

Middle Name  

Last Name  

Suffix. 

Relationship to Deceased – Select from dropdown list.  If not in list type it in manually and the field will turn 

orange. 

 

Note:  If the informant is the spouse, you will enter her married name in the informant field. 

Disposition Tab 

 

 

 

If more than one funeral home is involved, list the one starting the record in the first Funeral Home field.  You have 

the option to check “Do Not Print on Certificate” if you do not want it printed on the certificate.  List the other 

funeral home in the 2nd Funeral Home field.  This will allow both funeral homes to have access to the record.  

However, if the funeral home is an out of state funeral home and does not have a Nebraska licensed funeral director 

both funeral homes will have to be printed on the death record.  If the out of state funeral home has a funeral director 

who holds a Nebraska license, and is registered to use Nebraska’s VRERS then that funeral home can be printed on 

the death record by itself.  
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Disposition paragraph 

Method of Disposition – Select from dropdown list.  If what you need is not in the dropdown list you can type it in. 

If you happen to select Hospital Disposition you will get the following message.  The death certificate cannot be 

filed.  

 

Body Embalmed?  Select Y, N  

Disposition Date – Type in the Date of Disposition or use the Date Widget to select the date 

Covid – 19 Related Death? Select Y, N or U for Unknown 

Cemetery/Crematory State  - Select from dropdown.  If not in dropdown type in the Country and field will turn 

orange. 

City/Town – Select from dropdown.  If not in the dropdown type the City name and the field will turn orange.  

Cemetery, Crematory or Other Location - Select from dropdown.  If not in the dropdown type in the name and 

the field will turn orange.  

Funeral Home paragraph 

Trade Name – Prefilled and is how you logged on 

Do NOT print on certificate - Checkbox 

Name – Select from dropdown.  This name is based on the Trade Name. 

Address – Autofills after selecting the Name 

City – Autofills after selecting the Name 

State – Autofills after selecting the Name  

Zip Code – Autofills after selecting the Name 

Preferred Method of Contact – Autofills after selecting the Name 

Phone – Autofills after selecting the Name 

Extension – Autofills after selecting the Name 

Fax – Autofills after selecting the Name 

Email – Autofills after selecting the Name 

Trade Call paragraph 
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2nd Funeral Home – Select from dropdown list if there is a Nebraska License Funeral Director. 

 

Note:  If this is an out of state funeral home and does not have a Nebraska Licensed Funeral Director both funeral 

homes will have to be printed on the death record.  You will need to add the funeral home manually by selecting 

‘Other – not in list’.  If the out of state funeral home has a funeral director who holds a Nebraska license, and is 

registered to use Nebraska’s VRERS then that funeral home can be printed on the death record by itself.    

Trade Name – Will autofill after selecting 2nd Funeral Home if it’s in the dropdown list. 

Do NOT print on certificate – check box 

Address – Will auto populate after selecting 2nd Funeral Home if it’s in the dropdown list. 

City – Will autofill after selecting 2nd Funeral Home if it’s in the dropdown list. 

State – Will autofill after selecting 2nd Funeral Home if it’s in the dropdown list. 

Zip - Will autofill after selecting 2nd Funeral Home if it’s in the dropdown list. 

Email – Will autofill after selecting 2nd Funeral Home if it’s in the dropdown list.  If entered manually email is 

optional. 

 

Medical Tab 

 
The Physician will complete this tab and is for informational use only.   

 

Assigned Tab 
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Assigned To  

Certifier Type – Select from dropdown list.  Defaults to ‘Attending Physician’.  

Certifier Name, Location, and City – Choose certifier name and location from the dropdown list.  You can put in 

partial name and it will display the location and city and you can choose the correct one.  

 

You can filter on a partial Name, Location or City.  For example if I type in ‘Intern’ and you will see everything that 

is associated with ‘Intern”.   

 

Name – Will auto populate after selecting Physician Name, Location, and City field.   

Location – Will auto populate after selecting Physician Name, Location, and City field.   

Preferred Method of Contact – Will auto populate after selecting Physician Name, Location, and City field.   

Phone – Will auto populate after selecting Physician Name, Location, and City field.   

Extension – Will auto populate after selecting Physician Name, Location, and City field.   
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Email – Will auto populate after selecting Physician Name, Location, and City field.   

Send Email to Certifier  –  Click on this button when you want to send the notification email to the certifier to 

complete the record.  This is required by the Funeral Home for the email notification to be sent to the certifier.  

When selecting this button it will automatically be Saved without Edits. If the email sent date is not populated, the 

email is not sent because there are missing required fields for the email.  The required fields are First and Last Name 

of the decedent, date of death, date of birth and Funeral Home dropdown name. This process can be repeated once a 

day until the record has been signed by the certifier. 

Email Sent Date – This field will automatically populate when you click on the Send Email to Certifier button. 

Certifier Completed 

This paragraph will auto fill when the certifier signs the record.    

Reassign paragraph 

Reassign/Reject? – If the record has been assigned to an incorrect location the certifier will Reassign/Reject with a 

Y and an email will be sent notifying the funeral home that record needs to be reassigned.  

Reason for Rejecting – Certifier will select one of the three options why the record should be reassigned.  

 

Demographics Tab 
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Demographics paragraph 

 

Education  - Select from the dropdown list 

 

Hispanic Ethnicity (yes/no)? – Enter Y. N or U.  if you enter N it will autofill the Mexican, Cuban, Purto Rican and 

Other fields with an N.  If the Hispanic Ethnicity is ‘Yes’, ‘U’ cannot be selected for the rest of the Hispanic fields.  

You will need to select one or more that apply with a yes. 

 

Mexican – Enter Y, N  

 

Cuban - Enter Y, N  
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Puerto Rican - Enter Y, N  

 

Other - Enter Y, N.  If you select Y you will need to complete the Other Description field. 

 

Other Desc. – Enter description, example below. 

 

 
 

Occupation paragraph 

Decendent’s Usual Occupation – (do not use retired) – Select from dropdown list.  You can search by using a 

partial search, etc. For example you can type in ‘Farm’ and anything associated with ‘Farm’ will display in the 

dropdown list.  See screen shot below. 

 

 
 

If the Occupation is not in list type it in and the field will turn orange. 

 

 
 

Kind of Industry/Business – Select from dropdown list.  You can search by using a partial search, etc. For example 

you can type in ‘Bin’ and anything associated with ‘Bin’ will display in the dropdown list.  See screen shot below. 

 

 
 

If the Kind of Industry/Business is not in list type it in and the field will turn orange.   

 

 
Note:  Under the Help link there is additional information for Occup./Industry Instructions. 
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Race paragraph 

 

Check all races that apply: 

White – Check box 

Black – Check box 

Asian Indian – Check box 

Chinese – Check box 

Filipino – Check box 

Vietnamese – Check box 

Japanese – Check box 

Korean – Check box 

Hawaiian – Check box 

Samoan – Check box 

Guamanian or Chomorr – Check box  

 

American Indian – If this is checked then enter the Tribal affiliation(s) in the text box(s).  If unknown type in 

unknown in the Native Desc1.  

Native Desc 1 – Enter text    

Native Desc 2 – Enter text 

 

Other Asian –  If this is checked you will need to enter in their race in the description box(s). 

Other Asian Desc 1 – Enter text 

Other Asian Desc 2 – Enter text 

 

Other Pacific Islander – If this is checked you will need to enter in their race in the description box(s). 

Other Pacific Isl Desc 1 – Enter text 

Other Pacific Isl Desc 2 – Enter text 

 

Other – If this is checked you will need to enter in their race in the description box(s). 

Other Desc 1 – Enter text 

Other Desc 2 – Enter text 

 

Unknown – Check box  

 

Complete Tab   
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Funeral Home paragraph 

 

Embalmer Signed (Y/N)? – Yes/No text box.  This will be protected unless the body was embalmed.  It will need 

to be signed by the embalmer before the record can be completed. 

 

Date Signed – Will auto fill if Embalmer has signed the record. 

Funeral Director / Embalmer Name - Will autofill if Embalmer Signed is a Yes  

Embalmer License # - Will autofill if Embalmer Signed is a Yes  

Record Complete (Y/N/R)? – Yes/No text box.  This will be completed after the certifier signs the record.   

 

Complete Date  – Will autofill if Record Complete is a Yes  

Record Completed By - Will autofill if Record Complete is a Yes  

Fun. Home License # - Will autofill if Record Complete is a Yes  

 
Attending Physician or County Attorney or Coroner paragraphs 

 

Funeral Home has the option to Reject to Attending Physician and/or to Coroner or County Attorney if the 

information in the medical tab is incorrect.  Click on the appropriate reject button.  A Note will need to be added to 

notify the certifier as to why the record was rejected.  An email will automatically be generated to the medical 

certifier.   
 

Flags 

 
Note:  If you have received an email or notification that your record has been queried you can check this tab to see 

the status of the record.  If you want to check OVS (online verification with Social Security) you can check here.  
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USER PROFILE 
 

Click on Profile icon on the Toolbar.  Click on Edit Your Profile link which takes you to the profile page.  

 

If you want to click for your menu choices without hovering you can edit your Profile which is located on the right 

side of the page on the toolbar.  This will allow you to not hover over the submenus in the tool bar.  To change your 

preference from hovering, go to Profile button and click on Edit your profile link.  Then check the box next to ‘Use 

mouse-click to open/close submenus?’ in the Operations section of the profile page.  You may want to experiment 

with this to see what your preference is.  After making the change please remember to click on the Save butto n. 

  

 

 
 

You are able to change the functionality of the submenu’s and you can skip to the next field when the input length 

have been reached by checking the User mouse-click to open/close submenus or Skip to next field when input length 

reached.  See screen shot below.   
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MESSAGE ICON 
 

On the Toolbar there is an icon for messages so you can view your messages from here as well as on the Home 

page. 

 

  

Once you click on the messages icon a dropdown displays the link to view your messages.   

 

Click on the link and it will take you to your messages  for you to view.   

 

PRINTING DOCUMENTS/FORMS 
 

You can print when you have the death record displayed or when a record is highlighted on the Search Results 

screen, including Work Queues.   

 

Click on Documents >Documents>  choose document you want to print.  You can see the list of documents to print 

from the dropdown list.  In this example we are selecting D Office Copy Legal Size. 
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Example of documents below. 

 

 
 

If you are trying to print and you get the following message indicating that the popup is blocked, Follow the 

instructions below to enable the popup.    
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If you are using Chrome click on the ellipses in the upper right corner and go to Settings  

 

 
 

Once the Settings page loads click on Advanced 
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Once you click on Advance go to Content 
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Click on Popups 

 

 
 
 
The Popups page displays 

 
Click the Add button that is associated with Allow.  The Add window will display.  The in the following in the Site 

line:  https://vrers-dhhs.ne.gov/WebSvcVrers and click the Add button.  The site has been added to popups and 

you will no longer receive the popup blocker message.   

 

 
 

If you have Internet Explorer follow the instructions below: 

 

Click on the Setting icon in the upper right corner that looks like a gear. 

 

 
 

https://vrers-dhhs.ne.gov/WebSvcVrers
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Click on Internet Options 

 

 
 

Click on the Privacy tab, then click on the Settings button in the Pop-up Blocker section. 
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Type the following address in the Address of website to allow: https://vrers-dhhs.ne.gov/WebSvcVrers click 

the Add button and it will move to the Allowed sites box to allow popups on Internet Explorer.  

 

 
 

To Save as PDF in Chrome follow the instructions below: 

 

You can also print it as a PDF by clicking on the download arrow icon in the upper right.  

 

 
 

Once downloaded, it is in the download tray at the bottom.  Click to open.  It will open again in another window.   

 

Click the Download button again and the Save As window will display.  You can change the File Name to whatever 

you choose.  Verify that the Save as Type is Adobe Acrobat Document.   

 

https://vrers-dhhs.ne.gov/WebSvcVrers
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Click on the Print icon in the upper right to print the document. 

 

 
 

The following will display.  Select the Destination printer that you want to print to.  
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Click on ‘More Settings’ and then choose the appropriate paper size of what you are trying to print.  

 

 
 

REPORTS/EXPORTS 

Reports  
 
Report Center - Click on Batch >Reports 

 

 
 

Expand Death to see what reports you can select from. This example we are selecting Death Report for Funeral 

Homes. 
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Note:  You can also export the file to different file formats listed in the File Format dropdown and putting a check in 

the checkbox next to Export to a file. 

 

The report will open up in a separate window, example below. 

 
 

 

 

Note:  Follow the same steps for any report that you wanted printed. 
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Export: 

 Today’s Death Records Export Will Extract Date Range of Records 

 Export Can Be Run Multiple Times Throughout The Day 

 Export Will Be Protected Against Inadvertent Changes (Run Only Capability) 

 

Click on Batch > Export.   

 

Exports panel displays on the left of the screen.  You will need to click on the arrow to see the Funeral Home 

Records export.  Click on the Funeral Home Records export.  Screen shot below. 

 
The following page will display.  Leave the Create Output File checkbox checked and add the Output File Name.  

You then can uncheck the Create Report File and Create Summary File checkboxes.  Then you can add your 

parameters in Field, First Name (optional), Last Name (optional) and Date of death (mm/dd/yyyy) fields.  Now you 

can click on Run Export button. 

 

NOTE:  On the Date of Death field you can put in a  

 

 
 

The Export Results page will display with counts of records processed, written and total.  Click OK. 
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After clicking on the Execute button the Download buttons will become enabled in order to download the files.   You 

can save it to a location and name of your choice. 

 

 
 

When you click on Download button it will be in the bottom of the page.  Click on up arrow and choose Open.  

Notepad will open with the results of the report.  You can do a Save As here to a loca tion of your choice.  

HOW TO CHANGE SCREEN SIZES 
  

Many users may want larger text on their screen. The following instructions are for various browsers if you want to 

experiment with what size works best for you. 

 

To change the screen size in Chrome go to your ellipses button (looks like 3 dots).  Then click on the plus button 

next to Zoom in order to make your screen bigger.  Screen shot below. 
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To change the screen size in Microsoft Edge go to your Settings which is the eclipse (three dots) in the upper right 

corner.  Then click on the plus or minus buttons to zoom in out.  Screen shot below. 

  

 

To change the screen size in Firefox click on the hamburger button.  Then click on the Zoom button and choose to 

zoom in or out or choose the percent size you want.  Screen shot below. 
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To change the screen size in Safari hold the Command button down and click on + to increase the size or – to 

decrease the size.  Or you can click on View on the toolbar and choose Zoom In or Zoom Out.   

 

CONTACTS, HELP DESK 

 

Vital Records Help Desk:  402-471-8275 

Vital Records Nosologist:  402-471-0912 

Legal Questions:  402-471-0916 

Email – DHHS.deathdesk@nebraska.gov 

Add or Remove users – email DHHS.VitalRecordsHelpDesk@nebraska.gov    

mailto:DHHS.deathdesk@nebraska.gov
mailto:DHHS.VitalRecordsHelpDesk@nebraska.gov

